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1. Introduction
Note: This tutorial is a living document and will be updated and edited based on user feedback and comments.

If something isn't clear, or you have questions, don't hesitate to contact us and we'll work on updating it to

answer your questions.

Overview

This tutorial is designed to walk you through the process of creating the following floor plan using TouchDraw

for Mac.
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This tutorial was originally created using version 1.2.0 of TouchDraw for Mac. Depending on what version of

TouchDraw you are using, there may be some minor differences between what the screenshots show and what

is seen within the version of TouchDraw used for floor plan creation.

If you want to download the final file to see how it was constructed, you can download it here:

floor_plan_example.t2d

https://github.com/elevenworks/touchdraw-for-mac-floorplan-tutorial/tree/aac40067b7dd2409a60aa37a1ac1f342c9ece11a/attachments/5341362/5439534.t2d
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2. Step 1 - Creating a New Drawing
The first step in this tutorial is to create a new drawing. An untitled drawing will immediately be created when

TouchDraw is opened for the first time; however, the File Menu Old can be used to create a new drawing as

well.Click on the File Menu and select New when the application is already open.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/File+Menu+Old
http://docs.elevenworks.com/display/TDMAC/Creating+a+New+Drawing
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3. Step 2 - Selecting the Units
The second step is to configure the Unit of Measure for the drawing. Depending on where you live in the

world, TouchDraw will create a new drawing in Inches or Centimeters. For this tutorial, we are going use Feet

as the unit of measure; however, all of the following steps are equally applicable to other units of measure.

To configure the units of measure for the drawing, first click on the Canvas Tab in the Info Old section of the

Sidebar Old.

Once the Canvas Tab has been selected, click on the Units drop down menu and select Feet.

http://docs.elevenworks.com/display/TDMAC/Info+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Canvas+Old
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Continue to Next Step
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4. Step 3 - Configure Points Per
Unit
After the Unit of Measure has been changed, the drawing canvas will have 12 subdivisions for each inch in

feet rather than the original 8 subdivisions shown for inches. This is appropriate; however, at 100% zoom only

(approximately) 5' x 3' are visible on the screen.

The scale of the drawing must be adjusted before beginning to draw the floor plan. In TouchDraw for Mac this

is (currently) done through the Points Per Unit option, which is accessed by clicking on the Canvas Tab in the

Info Old section of the Sidebar Old as performed in the previous step.

http://docs.elevenworks.com/display/TDMAC/Canvas+Old
http://docs.elevenworks.com/display/TDMAC/Info+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
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The Points per Unit option is highlighted in the above screenshot. Simple math is necessary to calculate the

appropriate value for this setting.

First, the screen resolution used in this Mac example is 1024 x 768.

Second, the floor plan being drawn is 30' x 30'.

Third, taking into consideration that a little bit of a margin will be wanted on the side of the drawing, the

drawing view should be approximately 50 feet wide.

Fourth, the appropriate Points per Unit can be calculated by dividing 1024 (the number of horizontal pixels in

the screen) by 50 (the width of the drawing in feet).

This calculation supplies a value of 20.48; however, we can simply round to the nearest integer and use 20 for

setting the Points Per Unit. If a greater screen resolution will be used such as 1449 x 900, simply divide the

first number by 50 to obtain the correct Points Per Unit value, which provides the value of 28.98 or 29

(rounded up). For the sake of simplicity, the traditional screen resolution of 1024 x 768 is used in this tutorial.
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The drawing canvas will appear as below once the Points Per Unit option has been changed.

A future version of TouchDraw will perform the above calculation automatically by allowing the scale to be

selected from a list.

Continue to Next Step
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5. Step 4 - Creating the Exterior
Walls
Start by creating a simple rectangle 30 feet wide by 30 feet deep for the exterior walls of the floor plan. This

can be done by selecting the Rectangle Tool in the Drawing Toolbar on the left hand side of the screen.

Click and drag on the drawing canvas to create the rectangle. TouchDraw provides visual feedback by showing

the size of the shape at the top of the drawing canvas as the rectangle is drawn.

http://docs.elevenworks.com/display/TDMAC/Drawing+Toolbar
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If the rectangle is not exactly 30 ft x 30 ft on the first try, it is not a problem and one of many of the tools in

TouchDraw can be used to resize the shape. In the screenshot above, the rectangle is drawn approximately 10 ft

too wide. Click and drag on a corner of the rectangle after it is drawn to alter its size or enter a value for the W

(Width) attribute located in the Adjustment Tab of the Sidebar Old. The Adjustment Tab can be used to edit

the size of a currently selected shape.

A rectangle has four different associated values or attributes in the Adjustment Tab: x, y, w, h. X and Y

represent the position of the upper left hand corner of the selected shape in the drawing canvas. W and H are

the width and height of the shape in the currently selected unit of measure.

Either adjust the values by pressing on the up and down buttons or by clicking on the value to edit it directly.

The screen should appear as shown below after changing the width of the rectangle to 30:

http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
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Continue to Next Step
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6. Step 5 - Styling the Exterior
Walls
The next step is to change the styling (line thickness) of the exterior walls to make it obvious that these are

walls (as opposed to other details being added to the drawing in subsequent steps).

First, make certain the rectangle drawn in the previous step is still selected. Eight blue handles and one red

handle will be visible if the figure is selected. Click on the rectangle if it is not already selected.

Second, click on the Stroke Tab in the Sidebar Old to access the line thickness attribute and change it. Use the

buttons or text field under the Stroke Size Old section to change the value for the thickness of the line. The up

and down arrow buttons can be used to increment the value one by one or click in the text field to edit the

value directly.

For the purposes of this tutorial, the Stroke Size (line thickness) should be changed to 6.

http://docs.elevenworks.com/display/TDMAC/Selecting+a+Figure
http://docs.elevenworks.com/display/TDMAC/Stroke+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Size+Old
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Even though not all shown attributes are currently being used, these additional stroke (line) attributes can be

changed from this sidebar tab as well.

Continue to Next Step
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7. Step 6 - Locking the Exterior
Walls
Once the shape has been created and is positioned correctly, it is good practice to Lock the shape to prevent it

from being inadvertently moved.

First, make certain the drawn rectangle is still selected.

Second, open the Arrange Menu.

Third, select the Lockoption in the Arrange Menu to lock the shape.

After the shape has been locked, the options in the Arrange Menu will change.

This is because all of the menus in TouchDraw are _contextual_and only show valid options that apply to the

currently selected figure(s).

http://docs.elevenworks.com/display/TDMAC/Locking+Figures
http://docs.elevenworks.com/display/TDMAC/Selecting+a+Figure
http://docs.elevenworks.com/display/TDMAC/Arrange+Menu
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Second, once the Arrange Menu has been dismissed, you will notice the handles for the shape are no longer

blue and have changed to gray. This is a visual indication that the currently selected shape is locked and cannot

be moved.

Continue to Next Step
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8. Step 7 - Configuring the Layers
In order to organize the drawing better and allow editing of shapes that overlay other shapes without risking

selecting objects within the background, we will use the layers feature of TouchDraw. Imagine a stack of paper

where each layer is like a sheet of paper in that stack. One of those sheets of paper can be drawn without

impacting what's on the other sheets of paper; however, where layers differ is that layers are like transparent

pieces of paper. One sheet can be drawn while seeing what is on the sheets above and below it without

impacting them (if other layers are locked).

Right now, only one layer resides within the drawing (which has the default name "Layer 1"); however, when

the tutorial is completed, the drawing will have a total of 10 layers:

1Exterior Walls

2Interior Walls

3Door Cutouts

4Doors

5Stairs

6Bathroom Fixtures

7Fireplace

8Kitchen

9Dimensions

10Room Names

Open the sidebar (if not already visible) and use the Layers Panel at the bottom of the sidebar to begin setting

up the layers for the floor plan drawing.

http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Layers
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The Layers Panelcurrently lists Layer 1 as the only layer in the drawing.

Two icons (buttons) reside to the right of the layer name. The first button is both an indicator and toggle for

whether or not that specific layer is locked. The second button is both an indicator and toggle for whether or

not that layer is visible. When a layer is locked (and visible) the contents of that layer can be seen; however, it

will not be able to be selected or edited. This is a useful option for drawing over something in the background

without worrying about accidentally selecting or modifying it.

First, rename Layer 1 to Exterior Wallsby double clicking on the name of the layer in the Layers Panel and

then typing the new name. Click anywhere within the drawing canvas to complete the rename.

http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layer+Visibility
http://docs.elevenworks.com/display/TDMAC/Layers
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Next, press on the Lock Icon (Button) to lock this layer since no additional changes will need to be made to the

Exterior Walls.

Creating a layer for the interior walls is the next step of this process. To accomplish this addition, click on the

Layers Settings Menu in the Layers Panel and select the Add Layer option.

http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
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After selecting the Add Layer option, TouchDraw will add and select a new layer called Layer 2.

Repeat the steps above for renaming Layer 1 to _Exterior Walls_to rename Layer 2 to Interior Walls.

Note: Make certain the Interior Walls layer is selected (highlighted in blue) when completing this step. When

the shapes are created in the next step, they will be added to the currently selected layer, which should be the

Interior Walls layer.

Continue to Next Step
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9. Step 8 - Creating the Interior
Walls
The next step is to create the interior walls for the drawing. We created the following diagram to provide a

guide as to where the walls should be placed (also done as an additional layer within the TouchDraw drawing):

Start by drawing the the wall highlighted below.
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First, as with the exterior walls, the interior walls should be drawn with a line thickness of 6. TouchDraw will

remember that the last used stroke size was 6; however, it is good to know that the attributes (stroke, fill, text,

etc...) for a shape can be set before creating it. In this case, had the stroke thickness been changed in the

meantime, it could be set for all newly drawn lines by clicking on the Stroke Tab in the Sidebar Old and setting

the Stroke Size Old as done in a previous step.

Second, the Line Tool Old will need to be used to create the interior walls, as shown by the highlighted item in

the screenshot below.

From the dimensions shown above, we know that the first interior wall is 15 ft down from the top left of the

drawing (and also 15 ft up from the bottom left) and 4 ft long. As with drawing a rectangle, click and drag to

create a line.

http://docs.elevenworks.com/display/TDMAC/Stroke+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Size+Old
http://docs.elevenworks.com/display/TDMAC/Line+Tool+Old
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If the line is selected, all applicable dimension values to the line will appear in the Adjustment Tab of the

Sidebar Old after it has been drawn. The angle, length, start points, and end points of the line can be edited. As

before, either drag the blue handles or use the values in the Adjustment Tab to edit the location of the line.

Next, the dimensions above show a 3 ft 6 in open doorway to the right of the drawn wall. Draw a temporary

line in that space to use as a point of reference for other walls to be drawn later.

http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
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Move to the opposite side of the house and draw the 2 ft wall.

Next, as above, draw another temporary line for the 10 ft opening to the left of that wall.
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Draw the wall that fills the empty space between the two temporary lines.

Next, delete the two temporary lines since they are no longer needed. To do this, first click on one of the lines

to select it and then press on the Delete Key to delete the lines from the drawing.
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After both temporary segments have been deleted, the drawing should look like the following screenshot

example:

Next, as a matter of good practice, the created walls should now be selected and locked. They can be locked all

at once rather than going through the trouble of locking them one by one. With the Selection Tool enabled (the

one that looks like a pointing finger), perform a Click/Drag gesture combination to draw a rectangle around all

of the shapes and select them.

http://docs.elevenworks.com/display/TDMAC/Selecting+a+Figure
http://docs.elevenworks.com/display/TDMAC/Locking+Figures
http://docs.elevenworks.com/display/TDMAC/Selection+Tool
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Once all shapes have been selected, click on the Arrange Menu and select the Lockoption.

Next, draw the walls for the Kitchen Closet.

Either use the grid and the ruler as points of reference or draw temporary reference lines to get the proper offset.

http://docs.elevenworks.com/display/TDMAC/Arrange+Menu
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Next, draw the wall to the right of the refrigerator.
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Use the Rectangle Tool to draw the outline of the front closet and the half bath. (Note, by looking at the

dimensions above, we can figure out that this rectangle should be 4ft x 9 ft)

http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
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Draw the two 6 in walls between the foyer and the living room.

Lastly, create the wall between the front closet and the half bath.
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Now all of the lines representing the interior walls have been created.

Continue to Next Step
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10. Step 9 - Interior Wall Cleanup
Upon zooming in on the kitchen closet, you will notice that while the two endpoints of the lines touch, they do

not make a nice squared off corner. This is because each line is an individual object.

It is easy to remedy this within TouchDraw and can be fixed by combining the lines to create a single

compound path.

First, select both lines by drawing a selection rectangle that intersects with both lines as done previously. This

is the easiest way to select multiple shapes within the TouchDraw application.

Note: As of TouchDraw 1.8.3, if the selection rectangle is drawn from left to right, any object that intersects

with the selection rectangle will be selected. If the selection rectangle is drawn from right to left, then any

object that is contained within the selection rectangle will be selected.
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This action will cause both lines to be selected.

Next, click on the Modify Menu to combine both of the lines into a single compound path.

After the Modify Menu opens, select the Join Lines/Paths option:

http://docs.elevenworks.com/display/TDMAC/Selecting+a+Figure
http://docs.elevenworks.com/display/TDMAC/Modify+Menu
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After executing the Join Lines/Paths command and deselecting the newly created compound path, you will

see that the corner of the closet is now perfect.

Continue to Next Step
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11. Step 10 - Adding Door Cutouts
Layer
The next step in this process is to create a new layer for the Door Cutouts.

As with the previous step where a new layer was added for the Interior Walls, the same process must be

followed to create a layer for the Door Cutouts.

First, open the Sidebar Old (if not already viewable) and view the Layers Panel.

Second, lock the Interior Walls layer since no additional changes will need to be made.

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Layers
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
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Third, click on the Layers Settings Menu in the Layers Panel and select the Add Layer option to create a new

layer.

Fourth, as before, double click on _Layer 3_to change the layer name to Door Cutouts.

http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
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Lastly, make certain that the Door Cutouts layer is selected (highlighted in blue) and then dismiss the Layers

Panel by clicking outside of it.

Continue to Next Step
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12. Step 11 - Create Door Cutouts
The next step is to create the cutouts where the doors will go. The cutouts are nothing more than white filled

rectangles that cover the wall where the doors go and are added to make the walls invisible in that location.

The following diagram was created (also done as an additional layer within the TouchDraw drawing) to

provide a guide as to where the cutouts should be placed:
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For this type of work, it is often best to zoom in on the area where the work will be performed. Zoom in on the

front door and foyer closet portion of the drawing since the cutouts for these areas will be added first. To zoom

in on a drawing, either open the View Menu and select the Zoom In option, select a zoom percentage in the

Bottom Bar,, or use the Zoom Rectangle Tool in the Drawing Toolbar.

First, the front door is 5 feet from the left and a temporary line must be drawn to be used as a point of reference.

http://docs.elevenworks.com/display/TDMAC/View+Menu
http://docs.elevenworks.com/display/TDMAC/Bottom+Bar
http://docs.elevenworks.com/display/TDMAC/Zoom+Rectangle+Tool
http://docs.elevenworks.com/display/TDMAC/Drawing+Toolbar
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Next, use the Rectangle Tool to draw the cutout.

The rectangle was drawn with the current stroke setting (which was 6 points and black), so a few stroke

attribute changes will be necessary before continuing.

First, open the sidebar, click on the Stroke Tab, and change the the Stroke Size Old from 6 to 1.

http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Size+Old
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Next, change the stroke color to white. Click on the color square and then click on the center of the color wheel

in the standard color picker.

http://docs.elevenworks.com/display/TDMAC/Stroke+Color+Old
http://docs.elevenworks.com/display/TDMAC/Standard+Color+Picker
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The Stroke Color may also be changed through the Format Bar by clicking on the Stroke Color Button and

selecting white.

After the Stroke Color has been changed to white, you will see that our cutout is now styled correctly (with a

white stroke and a white fill).

http://docs.elevenworks.com/display/TDMAC/Format+Bar
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Next, duplicate the cutout and drag the copy to where the foyer closet door should go. To duplicate a shape,

first make sure it is selected and then either click on the Edit Menu or perform a Control/Click combination

anywhere on the drawing canvas to bring up the Contextual Menu and select the Duplicate option.

This action will create a duplicate that is slightly offset from the original.

http://docs.elevenworks.com/display/TDMAC/Duplicating+a+Figure
http://docs.elevenworks.com/display/TDMAC/Edit+Menu
http://docs.elevenworks.com/display/TDMAC/Contextual+Menu
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Then click within the bounds of the copy and drag it to where the foyer closet door should go.
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You will notice that the cutout has been centered within that wall; however, it will need to be made smaller as

that door should be 2ft 6in. For this adjustment, the easiest thing to do is to click on the left center handle and

move it over 3 inches and then click on the right center handle and move it to the left 3 inches.

Note: At this zoom level there is a grid stop every 3 inches (1/4 of a foot), which makes the above adjustment

easy. If we were to zoom in further, grid stops would appear every 1 inch.
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Next, move onto the side door. As seen in the example above, this door is 11 ft 7 in from the lower left hand

corner. Since a temporary line already exists on the drawing, we'll just drag the handles and re-use it for the

side door as well.
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At the current zoom level, the line can be dragged up 11.5 ft (11 ft 6 in); however, we'll need to zoom in more

to extend that temporary line the final 1 inch.
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As the temporary line is dragged, you can look at the info bar that pops up to make sure it is dragged to the

correct length.

Next, create the cutout rectangle for this door using the Rectangle Tool.

http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
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Select and delete the temporary reference line and create the cutouts for the rest of the doors by using the same

process as above to generate the result shown below:

http://docs.elevenworks.com/display/TDMAC/Selecting+a+Figure
http://docs.elevenworks.com/display/TDMAC/Deleting+a+Figure
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Continue to Next Step
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13. Step 12 - Adding the Doors
Layer
The next step is to create a new layer where the door locations are "cut out".

As with the previous step where a new layer for the Interior Walls was added, the same process must be

followed to create a layer for the Doors.

First, open the sidebar (if not already viewable) and lock the Door Cutouts layer since no additional changes

will not have to be made.

Second, click on the Layers Settings Menu and select theAdd Layer option to create a new layer.

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
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Third, as before, double click on the new layer (Layer 4) and rename it to Doors.

Lastly, make certain the Doors layer is selected (highlighted in blue or gray) and then dismiss the Layers Panel

 by clicking outside of it.

Continue to Next Step
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14. Step 13 - Adding the Doors
The next step in the process is to add the doors into the drawing. The following drawing was created by hiding

every layer except for the Exterior Walls, Interior Walls, Door Cutouts, and Doors to make it simple to

understand which way the doors should swing.

First, open the sidebar and navigate to the Architectural stencil sets in the Libraries Panel.

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Libraries
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Next, select the Architectural entry from the Library Selection Menu to view the architectural stencils. After

opening the Architectural stencil library, the Doors will appear at the top of the list.

http://docs.elevenworks.com/display/TDMAC/Libraries
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Click on the 36 in door in the stencil list and then drag it to the center of the drawing.

The inserted door will be much bigger than the scale of the drawing that is being worked on. This is because

the stencil was created at the "default" Points per Unit setting that was changed in the one of the earlier steps.

Note: The issue where the stencils aren't scaled to match the current Points per Unit will be in TouchDraw 2.0,

if not sooner.

To resize the door, use the width and the height entries in the Adjustment Tab of the Sidebar Old. Enter a value

of 3 for the width and the height since the front door should be 36" (or 3 ft).

http://docs.elevenworks.com/display/TDMAC/Canvas+Old
http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
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Now that the door is sized correctly, drag it down to the front door location for placement.

Note: It may be necessary to zoom in a little to position the door correctly within the door cutout. The

Adjustment Tab can also be used to set the doors X position to 5 and Y position to 27.

http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
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Next, duplicate the door by using the same technique used earlier in this tutorial.

http://docs.elevenworks.com/display/TDMAC/Duplicating+a+Figure
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Then drag the door to where the side door should be placed.

Note: Since this door is 11 ft 7 in from from the lower right, you will need to zoom in until the 1 inch grid units

are visible in order to place it correctly.

Next, use either the red Rotation Handle or the Rotate 90 Degrees Right command to rotate the door into it's

final position. The Rotate 90 Degrees Right command can be accessed by clicking on the Modify Menu and

then the Rotate Submenu.

http://docs.elevenworks.com/display/TDMAC/Rotating+a+Figure
http://docs.elevenworks.com/display/TDMAC/Modify+Menu
http://docs.elevenworks.com/display/TDMAC/Rotate+Submenu
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The side door will be in the correct location after executing the above command.

Next, duplicate this door to create a door for the bathroom.

http://docs.elevenworks.com/display/TDMAC/Duplicating+a+Figure
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As you can see, the orientation for this door is wrong and it needs to be flipped horizontally. Open the Modify

Menu, click on the Flip Submenu, and select the Flip Horizontally option.

The bathroom door will have the correct orientation after executing the Flip Horizontally command.

http://docs.elevenworks.com/display/TDMAC/Modify+Menu
http://docs.elevenworks.com/display/TDMAC/Modify+Menu
http://docs.elevenworks.com/display/TDMAC/Flip+Submenu
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Next, the size of the door must be edited. The bathroom door is 2.5 ft (2 ft 6in) and the Adjustment Tab in the

sidebar can be used to edit the size of the door. Once the size has been adjusted, zoom in on the bathroom door

and drag it to the appropriate location.

http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
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Next, use the same techniques as above (Duplicate, Adjustment Tab, Flip Horizontally, Flip Vertically and

Rotation) to create the doors for the rest of the openings.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Duplicating+a+Figure
http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
http://docs.elevenworks.com/display/TDMAC/Flipping+a+Figure
http://docs.elevenworks.com/display/TDMAC/Flipping+a+Figure
http://docs.elevenworks.com/display/TDMAC/Rotating+a+Figure
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15. Step 14 - Adding the Fireplace
Layer
The next step is to create a new layer for the fireplace.

As done in previous steps for adding new layers, the same process must be followed to create a layer for the

Fireplace.

First, open the sidebar.

Second, lock the Doors layer since no additional changes will be made.

Third, click on the Layers Settings Menu in the Layers Panel and select the Add Layer option to create a new

layer.

Fourth, as before, double click on the new layer (Layer 5) and rename it to Fireplace.

Lastly, make certain the Fireplace layer is selected and then dismiss the Layers Panel by clicking outside of it.

The Layers Panel should appear as shown below once these steps have been completed.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Adding+a+Layer
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
http://docs.elevenworks.com/display/TDMAC/Layers
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16. Step 15 - Adding the Fireplace
The next step in the process is adding the fireplace into drawing. The following drawing has been created to

make it simple to understand the dimensions of the fireplace.

The Path Tool will be used to create the Fireplace in one step rather than by using individual lines and the Join

Lines/Paths command to create a compound path.

http://docs.elevenworks.com/display/TDMAC/Path+Tool
http://docs.elevenworks.com/display/TDMAC/Joining+Lines+and+Paths
http://docs.elevenworks.com/display/TDMAC/Joining+Lines+and+Paths
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First, open the sidebar and click on the Stroke Tab to change the Stroke Color Old to Black since the last

drawn shape (door cutouts) used a stroke color of white.

The Stroke Color can also be changed through the Format Bar by clicking on the Stroke Color Button and

then selecting black.

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Color+Old
http://docs.elevenworks.com/display/TDMAC/Format+Bar
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Second, select the Path Tool (resembles the tip of a Calligraphy Pen) in the Drawing Toolbar.

Third, tap on the drawing where the lower right hand corner of the fireplace will go.

Next, move two feet to the left and tap on the drawing to insert the point for the lower left hand corner.

http://docs.elevenworks.com/display/TDMAC/Drawing+Toolbar
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Next, move up 1 foot and add the next point.

Add the next 5 points of the Fireplace by using the same process.
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Next, click on the starting point to close the path and finish the creation of the fireplace.

Next, you might have noticed that the fireplace is not in the correct position. It should be 4ft 6in from the lower
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right hand corner; however, it is currently 4 ft from this corner in the drawing. This is quite easy to remedy in

TouchDraw. Either zoom in and drag the shape up half a foot or use the Adjustment Tab  to change the shapes

Y position from 20 to 19.5.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
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17. Step 16 - Adding the Stairs
Layer
The next step is to create a new layer for the stairs.

As with previous steps where new layers were added, the same process must be followed to create a layer for

the Stairs.

First, open the sidebar.

Second, lock the Fireplace layer since no additional changes have to be made.

Third, click on the Layers Settings Menu in the Layers Panel and select the Add Layer option to create a new

layer.

Fourth, as before, double click on the created layer (Layer 6) to rename it to Stairs.

Lastly, make certain the Stairs layer is selected and then dismiss the Layers Panel by clicking outside of it.

The Layers Panel will appear as shown below once these steps have been completed.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
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18. Step 17 - Adding the Stairs
The next step in this tutorial is to add the stairs. First, as a point of reference for dimensions, the following is a

drawing showing the dimensions and relative locations of the stairs.

First, zoom in on the foyer area to make it easier to create the stairs. As seen in the diagram above, each stair

tread is 4 ft wide by 9 in deep. Use the Rectangle Tool to draw the first stair (closest to the front door).

http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
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If you look closely, you'll notice that the stairs overlap the exterior walls slightly. Use the Fill Tab in the Info

Panel of the sidebar to turn off the fill visibility for this shape and make it visually cleaner. Click on the Fill

Visibility toggle to disable (uncheck) this option.

http://docs.elevenworks.com/display/TDMAC/Fill
http://docs.elevenworks.com/display/TDMAC/Info+Old
http://docs.elevenworks.com/display/TDMAC/Info+Old
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Toggle the button to OFF (unchecked)to cause the drawn rectangle to no longer have a fill color.

Next, the rest of the stairs need to be drawn. One way would be to simply use the Rectangle Tool to draw the

remaining 8 stairs; however, this can be accomplished in a quicker manner within TouchDraw by using the

Paste Multiple... command.

First, copy the rectangle to the clipboard. As with the Duplicate command, this is done by performing an

Control/Click combination on the shape to bring up the Contextual Menu or by opening the Edit Menu and

then selecting the Copy option.

http://docs.elevenworks.com/display/TDMAC/Fill+Color
http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
http://docs.elevenworks.com/display/TDMAC/Cut+and+Paste
http://docs.elevenworks.com/display/TDMAC/Copying+a+Figure
http://docs.elevenworks.com/display/TDMAC/Duplicating+a+Figure
http://docs.elevenworks.com/display/TDMAC/Contextual+Menu
http://docs.elevenworks.com/display/TDMAC/Edit+Menu
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Next, open the Paste Special Submenu and navigate to the Paste Multiple... option. This is accomplished by

opening the Contextual Menu (as explained above) or the Edit Menu and clicking on the Paste Special

Submenuin either menu.

The option that we're interested in now is the Paste Multiple... option. Click on this option to select it and the

following options will appear.

http://docs.elevenworks.com/display/TDMAC/Paste+Special+Submenu
http://docs.elevenworks.com/display/TDMAC/Contextual+Menu
http://docs.elevenworks.com/display/TDMAC/Edit+Menu
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The Paste Multiple... option allows for a specified number of copies of the shape (or shapes) currently copied

to the clipboard to be pasted at specified increments. A total of 8 more steps will need to be inserted in order to

create the stairs. The Count entry must be changed to 8.

Next, change the X Offset field to 0 since the copies will only need to change position vertically from the

position of the original shape.

Next, enter -.75 ( 3/4 of a ft = 9 in) for the Y Offset since the steps are 9 inches high and they must be copied

upward (in the negative Y axis direction).

Click on the Paste Button to insert the copies.
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The next step is to insert the curve which delineates that there are stairs going both up and down in this location

and the Path Tool must be used to do this.

Since this is a slightly more complex operation, the steps will first be explained and then a video will be show

how to do this instead of having screenshots illustrating each step. Here is a diagram showing the points that

will be discussed in the explanation:

http://docs.elevenworks.com/display/TDMAC/Path+Tool
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Here is the explanation on how to create the curve.

1Select the Path Tool.

2Click at Point 1 and then drag over to Point 2 before releasing the click.

3Click at Point 3 and then drag over to Point 4 before releasing the click.

4Click on the Move and Zoom Tool to end the path creation process.

5Select the curve we just created.

6Click on the Stroke Tab in the Sidebar Old.

http://docs.elevenworks.com/display/TDMAC/Path+Tool
http://docs.elevenworks.com/display/TDMAC/Move+and+Zoom+Tool
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
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7Change the stroke size to 2

8Select the dotted line as the line style.

Here is a video demonstrating how to do the above steps.

Next, the arrows showing the direction for going up and down the stairs need to be added. The Line Tool Old

can be used to do this; however, the line style will need to be changed before doing so because the stroke size is

currently set to 2 and the line is set to a dash pattern.

Note: Make certain the curve is de-selected before changing the stroke settings, otherwise the stroke style of

the curve will be changed.

Change the stroke size to 1, change the dash pattern back to solid, and set the end decoration of the line to an

arrow within the Stroke Tab.

The lines can be drawn once the above stroke settings have been changed.

http://docs.elevenworks.com/display/TDMAC/Stroke+Size+Old
http://docs.elevenworks.com/display/TDMAC/Line+Tool+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Style+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Size+Old
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Continue to Next Step
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19. Step 18 - Adding the Bathroom
Layer
The next step is to create a new layer for adding the bathroom fixtures.

As with previous steps where new layers were added, the same process must be followed to create a layer for

the Bathroom Fixtures.

First, open the sidebar.

Second, lock the Stairs layer since no additional changes will be made.

Third, click on the Layers Settings Menu in the Layers Panel and select the Add Layer option to create a new

layer.

Fourth, as before, double click on the new layer (Layer 7) to rename it to Bathroom Fixtures.

Lastly, make certain the Bathroom Fixtures layer is selected and then dismiss the Layers Panel by clicking

outside of it.

The Layers Panel should appear as shown below once these steps have been completed.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
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20. Step 19 - Adding the Bathroom
Fixtures
Adding a toilet to the floor plan is similar to the process of inserting doors into a drawing. This is accomplished

by selecting a toilet from the Architectural stencil library and inserting it into the drawing.

The following screenshot shows how the drawing will appear after the toilet has been inserted.

http://docs.elevenworks.com/display/TDMAC/Inserting+a+Stencil+into+a+Drawing


Page 82

TouchDraw for Mac Floorplan Tutorial

As with the door, the toilet is not scaled correctly due to changes made to the Points per Unit setting in an

earlier step. As before, this is quickly remedied. Use the Adjustment Tab in the Info Panel to edit the width of

the toilet to 1.75 and the height to 2.

http://docs.elevenworks.com/display/TDMAC/Canvas+Old
http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
http://docs.elevenworks.com/display/TDMAC/Info+Old
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Next, the toilet will either need to be rotated 180 degrees by using the Rotate 180° command or flipped with the

Flip Vertically command since it is facing the wrong direction. Drag the toilet into place after it has been

rotated or flipped.

Use the Rounded Rectangle Tool Old to draw a sink for the bathroom. The Rounded Rectangle Tool is

located below the Rectangle Tool in the Drawing Toolbar.

http://docs.elevenworks.com/display/TDMAC/Rotating+a+Figure
http://docs.elevenworks.com/display/TDMAC/Flipping+a+Figure
http://docs.elevenworks.com/display/TDMAC/Rounded+Rectangle+Tool+Old
http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
http://docs.elevenworks.com/display/TDMAC/Drawing+Toolbar
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Draw the sink after the tool has been selected.
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Continue to Next Step
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21. Step 20 - Adding the Kitchen
Layer
The next step is to create a new layer in the drawing for the Kitchen.

As with previous steps where new layers were added, the same process must be followed to create a layer for

the kitchen.

First, open the sidebar.

Second, lock the Bathroom Fixtures layer since no additional changes will have to be made.

Third, open the Layers Settings Menu in the Layers Panel and select the Add Layer option to create a new

layer.

Fourth, as before, double click on the newly created layer (Layer 8) and rename it to Kitchen.

Lastly, make certain the Kitchen layer is selected and then dismiss the Layers Panel by clicking outside of it.

The Layers Panel will appear as shown below after the above changes have been made.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
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22. Step 21 - Adding the
Countertops
Adding the countertops is the first step required to complete the kitchen portion of the drawing. The following

diagram outlines the dimensions of everything that is needed to complete the kitchen:

First, zoom in on the kitchen.
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Next, use the Path Tool to add the each countertop section. Start by adding the smallest countertop, which is

located next to the refrigerator.

http://docs.elevenworks.com/display/TDMAC/Path+Tool
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Next, draw the countertop located next to the kitchen closet.

Finally, draw the large countertop.
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Continue to Next Step
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23. Step 22 - Adding the
Appliances
The next step in creating the kitchen is to add the appliances.

While some appliances are included in the architectural library, it is also easy to create these shapes using the

drawing tools provided within the TouchDraw application. In the following steps, the stove and refrigerators

are added by using tools in the Drawing Toolbar to demonstrate how these shapes can be created without

making a library selection.

We'll start first with the stove/range. First, use the Rectangle Tool to draw the back panel of the stove/range.

Next, draw the body of the stove/range.

http://docs.elevenworks.com/display/TDMAC/Drawing+Toolbar
http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
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Next, use the Oval Tool to create the burners on the range top.

http://docs.elevenworks.com/display/TDMAC/Oval+Tool
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Lastly, group all of the objects so that the drawn stove/range can be manipulated as one object. To group the

stove objects into a single object, draw a **Selection****Rectangle** around all of the shapes to make a

selection.

Note: Make certain the drawn selection rectangle is similar to one shown above so that it intersects only the

shapes in the stove. Doing so will prevent the complication of inadvertently selecting one of the countertops

and adding it to the group.

The range shapes will be selected after drawing the selection rectangle.

To group the shapes, go to the Arrange Menu and select the Group option.

Once the figures have been grouped, only the handles for the grouped figure will be visible as opposed to the

handles of each individual figure used to create the stove.

http://docs.elevenworks.com/display/TDMAC/Grouping+Figures
http://docs.elevenworks.com/display/TDMAC/Selecting+a+Figure
http://docs.elevenworks.com/display/TDMAC/Arrange+Menu
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Next, add the refrigerator into the kitchen. Start by drawing the body of the refrigerator with the Rectangle

Tool.

Next, insert an "R" into the drawn rectangle in order to make it more obvious that this object is a refrigerator.

TouchDraw makes it easy to add text to any shape. Simply Double Click on the rectangle to bring up the Text

Editor.

Enter "R" into the Text Editor and then click anywhere outside of the editor to dismiss it.

Next, draw the two "side by side" doors for this refrigerator. Use the Rectangle Tool as well to draw this

portion of the refrigerator.

Lastly, add the kitchen sink in the countertop by drawing two rounded rectangles inside of one another.

First, draw the outer rectangle.

Second, draw the inner rectangle.

Next, to make the two rounded rectangles look nicer next to one another, go to the Info Panel in the Sidebar

Old, select the Adjustment Tab, and edit the size of the Corner Radius of the inner rounded rectangle. The

appropriate value in this specific tutorial is .125.

We've now completed the kitchen.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
http://docs.elevenworks.com/display/TDMAC/Rectangle+Tool
http://docs.elevenworks.com/display/TDMAC/Editing+Text
http://docs.elevenworks.com/display/TDMAC/Editing+Text
http://docs.elevenworks.com/display/TDMAC/Rounded+Rectangle+Tool+Old
http://docs.elevenworks.com/display/TDMAC/Info+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Adjustment+Old
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24. Step 23 - Adding the
Dimensions Layer
The next step is to create a new layer for adding the dimension lines.

As with previous steps where new layers were added, the same process must be followed to create a layer for

the dimensions.

First, open the sidebar.

Second, lock the Kitchen layer since no additional changes will be made.

Third, open the Layers Settings Menu in the Layers Panel and select the Add Layer option to create a new

layer.

Fourth, as before, double click on the newly created layer (Layer 9) and rename it to Dimensions.

Lastly, make certain the Dimensions layer is selected and then dismiss the Layers Panel by clicking outside of

it.

The Layers Panel will appear as shown below after these steps have been completed.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
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25. Step 24 - Adding the
Dimension Lines
The next step in creating the floor plan drawing is to add some dimensions lines. TouchDraw makes it easy to

create dimension lines in a drawing.

First, use the Line Tool Old to draw the line that will make up the dimension line. Start by drawing the

dimension line for the vertical size of the dining room.

Next, click on the Stroke Tab in the Info Panel of the Sidebar Old to alter the start and end line styles to an

arrow with a horizontal line by clicking on the drop down selection menu, as shown below.

http://docs.elevenworks.com/display/TDMAC/Line+Tool+Old
http://docs.elevenworks.com/display/TDMAC/Stroke+Old
http://docs.elevenworks.com/display/TDMAC/Info+Old
http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
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Double Click on the line to open the Text Editor and enter  as the text for the line figure. Click anywhere

outside of the text editor to close it.

http://docs.elevenworks.com/display/TDMAC/Editing+Text
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The line ia now a dimension line with an auto-filled length and arrowheads on each end.

Use the same process as above to create the additional dimension lines for the drawing. A few shortcuts are

available for speeding up the creation of dimension lines. The following video has been created to demonstrate

the steps outlined above as well as to show a quick method for drawing the rest of the dimension lines with a

minimal amount of effort.

The Floor Plan should appear as below once all dimension lines have been completed.
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Continue to Next Step
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26. Step 25 - Adding Room Names
Layer
The next step is to create a new layer for adding the room names.

As with previous steps where new layers were added, the same process must be followed to create a layer for

the Room Names.

First, open the sidebar.

Second, lock the Dimensions layer since no additional changes will need to be made.

Third, open the Layers Settings Menu in the Layers Panel and select the Add Layer option to create a new

layer.

Fourth, as before, double click on the newly created layer (Layer 10) to rename it to Room Names.

Lastly, make certain the Room Names layer is selected and then dismiss the Layers Panel by clicking outside

of it.

The Layers Panel should appear as shown below once these steps have been completed.

Continue to Next Step

http://docs.elevenworks.com/display/TDMAC/Sidebar+Old
http://docs.elevenworks.com/display/TDMAC/Locking+Layers
http://docs.elevenworks.com/display/TDMAC/Layers+Settings+Menu
http://docs.elevenworks.com/display/TDMAC/Layers
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27. Step 26 - Adding the Room
Names
The final step in this tutorial is to add text areas for labeling the rooms with their appropriate names. Use the

Text Tool to label each room.

After selecting the Text Tool, click in a location in the drawing to insert a text box. TouchDraw will insert a

text box and immediately open the Text Editor for entry. A double click will re-open the text editor if it is

closed prior to entry.

http://docs.elevenworks.com/display/TDMAC/Text+Tool
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Enter the name of the room into the text box and click anywhere outside of the text editor.

Repeat the process for the rest of the rooms (Dining Room, Kitchen and Foyer) in the floor plan.
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Lock the Room Names Layer to prevent further changes to the drawing.

And with that last step, we have completed our drawing.

http://docs.elevenworks.com/display/TDMAC/Locking+Layers
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